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Chemistry 111 Laboratory 
Experiment 3:  An Exploration of Molecular Shapes: 

MacSpartan Pro and Molecular Models 
(This activity will be conducted in Olin-Rice 341) 

 
Introduction 
The three-dimensionality of a molecule is critically linked to its chemical and physical 
properties.  For example, the bent geometry of water causes its polarity.  The polarity of a 
molecule (or lack thereof) strongly influences its boiling point, freezing point, reactivity, and 
countless other properties.  The key biochemical interactions between an enzyme and a substrate 
rely on specific structural characteristics of each molecule.  A sound understanding of molecular 
shapes is necessary to fundamentally understand chemical and biological phenomena.  Chemists 
routinely predict the structural characteristics of proposed molecules when designing substances 
for specific applications.  The structure of a molecule is inherently linked to its function. 
 
Valence Shell Electron Pair Repulsion Theory (VSEPR) is a systematic methodology for linking 
a two-dimensional Lewis structure to a molecule’s three-dimensional shape.  The application of 
VSEPR permits the reliable prediction of molecular structure and bond angles.  This information 
can be used to subsequently determine other molecular properties (e.g., dipole moments).  
 
This experiment will provide an opportunity for you to use computational chemistry software to 
calculate and observe shapes of molecules.  Concurrent with your construction of molecules in 
MacSpartan Pro, we will ask you to build representations of molecules with a molecular model 
kit.  A successful study of chemistry requires that one be able to visualize molecules in three-
dimensional space using both hand-held models and via a computer screen.  We hope that you 
enjoy using the MacSpartan Pro software to gain a new perspective on VSEPR.  MacSpartan Pro 
is a “common thread” through our chemistry curriculum, as it is used in General Chemistry II, 
Organic, Physical, and Advanced Inorganic Chemistry courses at Macalester College.  
MacSpartan Pro is also a critical aspect of next week’s Chemistry 112 experiment, as we 
continue to explore chemical bonding. 
 
Ground Rules 
We encourage you to work in groups of two for this experiment.  However, please take turns at 
the mouse so that everyone gains a solid proficiency with MacSpartan Pro.  In addition, it is 
important that all students learn how to use the Molecular Visions® model kit.  All information 
documented in your laboratory notebook should be turned in as your report for this 
experiment.  Make sure that each table/answer is clearly labeled to help us follow your work. 
 
Drawing Molecules and Calculating Bond Angles with MacSpartan Pro: 

A Good Starting Point:  Identical Coordination and Steric Numbers 
 
The best way to start an investigation of VSEPR is to consider some fundamental molecular 
shapes that are free of distortions.  Let’s explore the molecule BF3 as our first example! 
 

• Design a laboratory notebook table to clearly present information with the following 
headings:  “Lewis Structure,”  “Coordination Number,” “Steric Number,” ”Shape Name,” 
and “Calculated Bond Angles.” 

 
• Draw the Lewis structure of BF3.   
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The following molecular geometries apply when the steric number equals the coordination 
number: 

Steric Number Shape 
2 Linear 
3 Trigonal planar 
4 Tetrahedral 
5 Trigonal bipyramidal 
6 Octahedral 

 
• Record the “Shape Name” for BF3 in your laboratory notebook.  
 

To start MacSpartan Pro, click on the desktop icon labeled “Macintosh HD”.  Select “Chemistry 
Applications” from the left field of the window.  Choose the icon labeled “MacSpartan Pro 
Alias” from the applications that appear.  MacSpartan Pro may take a few moments to load. 
 
Will MacSpartan Pro predict the same structure for boron trifluoride?  Let’s find out! 
 

• Select New from the File menu.  The Model Kit window will appear.  This is your palette 
for drawing chemical species (atoms, molecules, ions, or even groups of molecules/ions). 

 
• Select the Expert tab. 

 
A common practice in computational chemistry, the study of molecular properties with computer 
software, is to begin with a structure that the chemist believes approximates the naturally 
occurring structure.  This makes for more efficient calculations as it saves computer time.  We’ll 
take this strategy (using VSEPR as our guide) with the molecules in this experiment. 
 

• Select the arrangement of electron pairs (with X as the central atom) that best matches 
your prediction for boron trifluoride. 

 
• Change the central atom to boron by clicking on Element and choosing Boron from the 

periodic table. 
 

• Click in the center of the green drawing workspace to place a three-coordinate boron 
atom.  Rotate the molecular fragment so that you can see all three “half-bonds” by 
clicking and dragging on the green workspace background. 

 
• If you make a mistake and need to start over, choose Clear from the Edit menu. 

 
Our next objective is to add the three fluorine atoms. 
 

• Select the Entry tab.  Select the fluorine atom icon. 
 
• Click on each “half-bond” of the boron atom to complete the three boron-fluorine bonds. 

 
Now we are ready to begin our computer calculation. 
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• Select Save As under the File menu.  Save your structure with a generic name, like your 
name, because if you follow these directions correctly this should be the only time you 
save!  Don’t use a specific name like “Boron Trifluoride.” 

 
• Select Calculations from the Setup menu. 

 
• Setup the calculation to determine the “Equilibrium Geometry” with “Molecular 

Mechanics” and “MMFF” (Molecular Mechanics Force Field).  Start from the “Initial” 
geometry.  Deselect “symmetry”.  Click “OK”. 

 
•  Select Submit from the Setup menu to begin the calculation.  Select OK to 

acknowledge the beginning and the end of the calculation. 
 
The trigonal planar boron trifluoride molecule should be in the workspace.  In this case, the 
calculation should have verified that the entered geometry is the optimum structure for BF3.  We 
encourage you to rotate the molecule by clicking and dragging on the workspace.  Verify that the 
molecule is planar by viewing it from different perspectives.  Before we examine the bond angles 
of boron trifluoride, let’s play with our optimized molecule to learn more about MacSpartan Pro. 
 

• Enlarge/Reduce the Molecule:  Depress the option and apple keys simultaneously while 
dragging the mouse in the appropriate direction to achieve the desired effect. 

 
• Molecule Representation:  The way in which a molecule is displayed can be changed by 

switching between the “wire”, “ball and wire”, “tube”, “ball and spoke”, and “space 
filling” options under the Model menu.  Try out these different options for fun. 

 
• Move the Molecule:  Depress the mouse and option key simultaneously while moving the 

mouse. 
 

• Rotate the Molecule in the X/Y Plane:  Click on the background and drag the mouse in 
the desired direction. 

 
• Rotate the Molecule in the Z Plane:  Depress the mouse and apple key simultaneously 

while dragging the mouse in the desired direction. 
 

Now let’s examine the molecule in terms of its bond angles!  The shape of a molecule is defined 
by its bond angles.  
 

• From the Geometry menu, select Measure Angle. 
 

• Determine the three bond angles by sequentially clicking on each set of three atoms that 
define each molecular angle.  It is important to select boron as the second atom during the 
determination of each angle.  Each angle will be displayed in the lower right corner of the 
workspace.  Click on the workspace background to “deselect” each angle before finding 
the next one. 

 
• Record the calculated angles for boron trifluoride, a classic trigonal planar molecule, in 

your laboratory notebook.  If they are all identical, you don’t need to list them all 
separately, just say “All bond angles = “ and specify what the angle was. 
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Our next goal is to determine bond angles for other chemicals with identical coordination and 
steric numbers. In this regard, we need to conduct calculations on linear, tetrahedral, trigonal 
bipyramidal, and octahedral molecules. 
 

• Delete your BF3 molecule by selecting Clear from the Edit menu. 
 
• Conduct the same steps in your notebook (write the “Lewis Structure,”  “Coordination 

Number,” “Steric Number,” “Shape Name,” and “Calculated Bond Angles”) for the 
following molecules:  CO2, CH4, PF5, SF6.  (Note:  Students who enroll in Physical 
Chemistry I (CHEM 311) have the opportunity to study SF6 in the laboratory.) 

 
Useful Information (Ask for assistance with any of the molecules/calculations if necessary) 
 
1.  Use the Expert window for the complete construction of CO2.  Select carbon as the element.  
Choose the icon from the first two rows that represents the geometry about the carbon.  Click the 
central atom into the workspace.  Next, select the bond type (from the third row of icons) that 
matches the carbon-oxygen bonds of your Lewis structure.  Double click on each bond to change 
the bond type.  Finally, add the terminal oxygens from the Entry Model Kit. 
   
2.  For CH4, PF5 and SF6, use the Expert Model Kit window for the central atom and the Entry 
Model Kit window to add the outer atoms. 
 
3.  The tetrahedral icon is the first one in the second row of the Expert Model Kit window.  The 
trigonal bipyramidal icon is second from the left in the second row.  The octahedral icon is the 
last one in the second row.  The funny little circle on the trigonal bipyramidal structure is just 
supposed to indicate that the bond it is on is coplanar with the top and bottom bonds.  It will not 
show up when you click your P for PF5 into the green drawing space. 
 
4.  You will need to rotate some of the structures to add outer atoms. 
 
5.  Use the same calculation parameters (Molecular Mechanics, MMFF, deselect symmetry) for 
all of these molecules. 
 
6.  Record the two unique bond angles for the trigonal bipyramidal molecule. 
 
7.  Rotate each molecule to obtain a good perspective of these molecular geometries. 
 
8.  We strongly recommend AGAINST using Open and Close on the File menu.  If you do 
decide to go that route, be sure to re-set the calculation parameters for each molecule! 
 

• Make sure that your notebook entry is complete before going on to the next part of the 
experiment.  You should specify which columns in your table were calculated using 
Spartan Pro, and what calculation parameters were used.  It is important that someone 
reading your lab book be able to ascertain what calculation parameters were used in 
calculating each of your results, but since these parameters are generally held constant 
throughout a given table, you can usually just specify what they were for an entire given 
table. 
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VSEPR and Molecular Distortions:  Molecules with Different Coordination and Steric 
Numbers 
 
Molecules with bonding and nonbonding electrons on their central atoms are susceptible to 
distortions (i.e., non-ideal bond angles).  Let’s investigate some of the features that lead to 
distortions.  Our goal is not only to rationalize why molecules possess distortions, but 
ultimately to estimate distorted bond angles from Lewis structures.    
 
Let’s look at the impact of nonbonding pairs on molecules whose central atoms have a steric 
number of 4.  A classic series includes CH4, NH3, and H2O.  We’ve already examined methane, 
so let’s look at ammonia next! 
 

• Start a new table, whose headings and first row look like this: 
 
Lewis 

Structure CN SN Undistorted Geometry Calculated Geometry 

C

H

H H

H  

4 4 

CH3

CH3

CH3

CH3

 109.5o

All angles 109.5° 

CH3

CH3

CH3

CH3

 109.5o

All angles 109.5° 
 
• Write the “Lewis Structure,”  “Coordination Number,” “Steric Number,” and “Shape 

Name” for NH3 on the next row of this table.  Based on your Lewis structure, draw in the 
undistorted geometry for ammonia (NH3). 

 
• Since the arrangement of the electron pairs around nitrogen is tetrahedral,, let’s draw NH3 

in Expert mode by selecting a tetrahedral nitrogen and placing it in the workspace.  Add 
the three hydrogen atoms in either Expert or Entry mode. 

 
• The remaining “half-bond” is the tetrahedral environment associated with the nonbonding 

pair in your Lewis structure.  Although we can’t see the lone pair, these electrons impact 
the shape of this molecule.  Delete the “half-bond” by clicking on the minus sign button 
on the left-hand palette, and then clicking on the “half-bond”.  If a rogue atom appears 
after deletion of the “half-bond,” delete that too. 

 
• Before you submit the calculation, measure the bond angles and record them 

(“undistorted geometry”) in your laboratory notebook.  Since you employed tetrahedral 
nitrogen during the construction, your angle should be identical to that of methane. 

 
• Setup and submit the calculation using the familiar parameters (Molecular Mechanics, 

MMFF, Initial geometry, deselect symmetry). 
 

• Measure the bond angles and record the calculated values.  In this case, the calculation 
determined that 109.5o isn’t the optimum angle for NH3.  The angles determined by 
MacSpartan Pro reasonably approximate the actual angles of ammonia. 
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It’s very important to realize the importance of submitting your molecule.  Until you do so, 
Spartan makes assumptions that aren’t any more sophisticated than the ones you make when you 
use Lewis dot structures and VSEPR.  Spartan is an expensive and useful program precisely 
because of what it does when you hit submit: it carries out detailed quantum mechanical 
calculations on your molecule, which do a decent job of predicting the real shape of the 
molecule, including the impact of distortions.  Throughout the remainder of this lab, if you 
neglect to submit you molecule, or don’t use the specified calculation parameters, you’ll be 
unhappy.  I know some of you aren’t into submissive behavior, but this is a good time and place 
to get into it, at least for a little while.  => 
 
Ammonia, with CN = 3 and SN = 4, has a trigonal pyramidal geometry.  Enlarge/rotate your 
molecule as necessary to view the trigonal pyramidal shape. 
 

• Measure the bond distances using the same menu.  Record these data (in Angstroms) on 
the “calculated geometry” structure you’ve sketched in your notebook.  

 
To investigate the impact of nonbonding pairs further, let’s examine H2O. 
 

• Follow steps analogous to those for NH3.  Measure and record the undistorted bond 
angles before you submit.  Then calculate and record the actual geometry’s bond angle 
and bond distances. 

 
Water, with CN = 2 and SN = 4, has a bent geometry.  Hydrogen atoms occupy two of the 
tetrahedral sites, while the other two sites are associated with the nonbonding pairs.  The atomic 
positions define the molecular shape. 
 

• Discuss the bond angles of CH4, NH3, and H2O in your notebook.  Describe the relative 
impact of bonding vs. bonding electron pairs on the distortion of SN = 4 molecules.  
Hypothesize about the origin of these distortions (i.e., Why does a nonbonding pair exert 
a different influence relative to a pair of bonding electrons?). 

 
Other Factors that Influence Molecular Shapes 

 
Okay, so we’ve got a pretty good grip on how unbonded electrons can distort molecules…what 
else might impact distortions?  Let’s consider two more molecules and see.  Adding to your table 
above, and using an analogous approach, investigate these two molecules: 

1) Formaldehyde, H2C=O  (CH2O, with the oxygen double-bonded to the carbon) 
2) Hydrogen sulfide, H2S 

 
Comparing the distorted and undistorted bond angles in formaldehyde will give you some idea of 
the impact that a double bond can have on the geometry of a molecule.  Comparing H2S with 
H2O will give you some indication of the importance of atomic radius on distortions.  Based on 
these results, comment in your lab book on the effect of double bonds and atomic radius on 
bond angle distortions. 
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Hand-Held Models, Bond Angle Predictions, and MacSpartan Pro: 
 
Although the inspection of molecular shapes on the computer screen is instructive, it is also 
useful to hold a representation of a molecule in your hand.  Molecular model kits are valuable 
tools to essentially all chemists.  The Molecular Visions® model kit is used extensively by 
Macalester students in Organic Chemistry (CHEM 211-212).  
 
The labels on the components of this model kit feature hybridization terminology (sp-3, sp-2, 
etc.) that will be discussed in class very soon.  For now, use this information to guide your 
selection of appropriate pieces: 
 
Description of Model Kit Piece Element Geometry 
Black, SP-3 Carbon Tetrahedral 
Red, SP-3 Oxygen  Tetrahedral 
Blue, SP-3 Nitrogen  Tetrahedral 
Light Green, SP-3 Fluorine Tetrahedral 
Pink, SP-3 Chlorine Tetrahedral 
Grey, SP-2 Carbon, Nitrogen or oxygen Trigonal Planar 
Grey, rectangle Carbon-Carbon Double Bond  
Grey, U-shaped Two of these can be assembled to create a carbon-carbon 

double bond. 
Red, U-shaped Two of these can be assembled to create an oxygen-oxygen 

double bond.  Note that red and grey half-length U-shaped 
pieces are assembled to best indicate a carbon (or nitrogen) 
to oxygen double bond. 

Pink, T-shaped Two of these can be assembled to create an octahedral 
electron-group geometry. 

Grey, Triangle and Grey, 
Straight 

These two pieces can be assembled to create a trigonal 
bipyramidal electron-group geometry. 

Any Color Ball Hydrogen atom 
 

• Draw the Lewis dot structure of acetone, C3H6O, in your lab book.  The oxygen atom in 
acetone is connected to a single carbon atom, with no hydrogen atoms connected to 
this same carbon atom.  Acetone is the primary component of fingernail polish remover. 

 
• Construct a molecular model of acetone, C3H6O, using the Molecular Visions model kit. 

You will need to obtain two black carbon clusters, one grey carbon center and one grey 
double bond, and one red oxygen atom from the drawers of the rolling cart.  You can use 
balls of any color to represent your hydrogen atoms – you’ll need six.  Lone pairs will 
“appear” in your model as bonds with nothing at the end of them.  Feel free to ask your 
lab instructor or assistant for help. 

 
• Ask your lab assistant or instructor to inspect your hand-held model before disassembly.  

Your lab assistant/instructor will initial your Lewis Structure if all aspects of your model 
and structure are correct. 
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• Select Molecular Mechanics, MMFF, Initial geometry, and deselect symmetry for 
your MacSpartan Pro acetone calculation.  Determine the calculated <OCH and <CCC 
angles and record these appropriately on a Lewis structure in your laboratory notebook. 

 
• Rationalize the distortions of the two bond angles you studied for acetone.  What’s 

causing them to distort the way they do? 
 

• Repeat the same procedure [construct hand-held model, show your lab 
instructor/assistant, calculate angles using MacSpartan Pro (Molecular Mechanics, 
MMFF, deselect symmetry), and rationalize deviations] for the following molecules: 

 
Ethylene, C2H4  
 
Diethylamine, NH(CH2CH3)2 Set “Start from:” to MMFF Conformer for diethylamine.  

Analyze only the <CNC bond angle. 
 
Nitrate anion, NO3

- Nitrate ion has a steric number of 3.  Include reasonable 
resonance forms with formal charges in your Lewis 
Structure representation.  Enter one of these resonance 
forms into Spartan Pro using Expert mode.  Indicate 
“Anion” (-1) as the Total Charge in the Setup:Calculations 
menu, and set “Start from:” back to Initial Geometry. 

 
Return each of your MolecularVisions® model kit components to the drawer it came from. 
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Trigonal Bipyramidal Preferences 

 
The “placement” of the nonbonding pairs was straightforward in the previous examples, since 
each site about the central atom was equivalent.  This is not the case with trigonal bipyramidal 
molecules.  The sites that are 120o apart are called “equatorial,” while the sites that are 90o 
relative to the equatorial sites are called “axial”.  These two types of sites are geometrically 
distinct – they are qualitatively different environments.  Do nonbonding pairs prefer 
equatorial or axial sites in molecules with trigonal bipyramidal electron-group geometries? 
 
The molecule iodine trifluoride, IF3, which has CN = 3 and SN =5, serves as a good example.  
There are three unique relative placements of the nonbonding pairs between the equatorial and 
axial sites of this molecule.  They can be both axial, both equatorial, or one axial and one 
equatorial.  
 

• Draw each of these possible three-dimensional shapes in your notebook.  Sketch the 
molecules to indicate the positions of nonbonding pairs on the trigonal bipyramid as best 
you can.  Come up with a unique name for each structure, based on the locations of the 
two nonbonding pairs. 

 
• Generate a table in your notebook to clearly communicate the following structural 

features for each possibility.  Consider an ideal structure trigonal bipyramidal structure 
(i.e., no distortions) for these determinations. 

 
1. Number of 90o angles between nonbonding pairs.  (Note:  This angle cannot be 

experimentally measured since electron positions cannot be located with high 
precision.  However, this “angle” is useful in rationalizing trigonal bipyramidal 
preferences.) 

2. Number of 90o angles between nonbonding pairs and bonding pairs.  (Note:  
This angle is also impossible to measure experimentally.) 

3. Number of 90° angles between bonding pairs.  (These angles can be measured 
experimentally, and provide some insight into the immeasurable ones above.) 

   
Hint:  Each structure has a total of six 90o interactions.  All that differs is what type these six are.  
Feel free to ask for help to verify your approach to counting these angles. 
 
Based on what you have learned already during this experiment, can you speculate on which 
structure might be the “best” (i.e., the lowest energy of IF3)?  Rank the structures from “best” 
to “worst” and briefly provide your rationale.  It is important for chemists to try to anticipate 
the outcome of computer calculations, and not accept the computed results blindly.  Computer 
calculations don’t rely on “chemical intuition,” so hypotheses held by the experimentalist can 
help rule out unreasonable outcomes.  Don’t worry.  Points won’t be deducted for your selection 
of “best” and “worst,” but only for the clarity of your discussion/rationale. 
 
Let’s find out which structure MacSpartan thinks is the lowest energy geometry for IF3.  Nature 
defaults to the lowest energy state available, so the geometry with the lowest energy best 
represents the naturally occurring structure. 
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MacSpartan Pro can calculate the approximate energies of molecules.  Indeed, the calculation of 
these energies is one of the primary applications of computational chemistry software.  In this 
study, the relative energies of the three possible structures are of more interest than their 
absolute energies. 
 

• Draw one of the structures by starting with a trigonal bipyramidal iodine fragment in the 
Expert mode.  Add the fluorine atoms into the appropriate equatorial or axial locations 
via either Entry or Expert mode.  Delete the remaining “half-bonds” (and resulting 
extraneous atoms) to indicate the locations of the nonbonding electrons. 

 
In this case, a calculation of “Equilibrium Geometry” isn’t appropriate.  Our objective is to 
determine the energy of each structural possibility for comparison purposes.  A calculation of 
“Equilibrium Geometry” starting with any of these three possibilities should (if the proper level 
of theory (calculation method) is applied) provide the naturally occurring structure, along with 
any distortions in the actual molecule.  The appropriate calculation here is called “Single Point 
Energy.”  A Single Point Energy calculation simply provides the energy associated with the 
submitted structure.  The shape of the molecule won’t change during the calculation, in contrast 
to previous calculations.  In this way, a “Single Point Energy” calculation doesn’t provide 
information about distorted angles.  However, it will permit a ranking of our three possibilities in 
terms of energy. 
 

• Conduct a calculation (Single Point Energy, Semi-Empirical, AM1, deselect 
symmetry) on your structure. 

 
• Record its energy (provided in kcal/mol at the bottom of the workspace) next to the 

corresponding structure in your notebook. 
 

• Repeat these steps for the remaining two structures. 
 

• Which structure best represents naturally occurring IF3?  Was your prediction correct?  
Based on your ranking of possible structures, discuss the “rules” that govern 
trigonal bipyramidal preferences.  If you already (correctly) outlined these rules in 
making your hypotheses up above, it’s enough to simply state that here.  (What feature is 
most “destabilizing” for a CN = 3, SN = 5  molecule?  What distinguishes the best 
structure from the second best possibility?  Be specific.). 

 
Starting with the best structure of IF3 (redraw in a new window), calculate the distorted bond 
angles in this molecule.  For this calculation, use “Equilibrium Geometry”, “Semi-Empirical”, 
“AM1” and deselect “symmetry”.  This geometry is called “T-shaped”.
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Name________________________________ 

 
Chemistry 112 Laboratory 

Experiment 4:  An Exploration of Molecular Shapes:   
MacSpartan Pro and Molecular Models 

 
Advance Study Assignment 

 
Read through the experiment carefully and then provide a 1-2 sentence synopsis of the objectives 
of the experiment in the box below. 

 
 
Please provide the answers to the following questions on this page. Bring it with you, completed, 
when you come to lab. 
 

1. Knowledge of periodic trends is important to understand the subtler aspects of VSEPR 
theory.  Explain fundamentally why a sulfur atom is larger than an oxygen atom. 

 
 
 
 
 
 
 
 
 
 
 

2. Rank the following isoelectronic species in order of increasing (a) size, (b) ionization 
energy, and (c) electron affinity. 

 
Cl-, K+, Ca2+ 
 

 


